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Various SED units / departments

® SED has multiple units that play a role in the Preschool process:

= STAC Unit (https://www.oms.nysed.qov/stac/ )
The primary unit that Counties will interact with for Preschool.
= Rate SEttlng (https://www.oms.nysed.qov/rsu/ )

The Rate Setting Unit approves and issues all rates for Preschool Services

g Medicaid In Education (https://www.oms.nysed.gov/medicaid/ )

The Medicaid in Education handles all Medicaid Policy for Preschool
Aka. MedinED




Processes STAC-ID requests batches.
® Issues STAC-ID return files.
Processes STAC-ID problem spreadsheets.

Processes children’s name changes & other info changes.

STACUnit: STACID's

® SED’s STAC Unit issues and maintains children’s STAC IDs.
A 6-digit number that identifies a child receiving CPSE/CSE services.

STAC-703 The University of the State of New York
THE STATE EDUCATION DEPARTMENT

Child Information Change Form

lity representative.

Rev. 08/2023

This form is used by representatives of School Districts and Municipalities to request changes in
how a child’s name or other identifying information is recorded on the STAC Online (EFRT)

let, director of pupil personnel services, or

Sean and upload completed forms to SED File Transfer Manager (FTM) “inbasket”.
Email OMSSTAC@ nysed.gov with the SED FTM location and filename.

Do NOT attach completed forms to emails.

Chid's Lasi Name as listed on EFRT ]

Chikds Firsi Name as listed on EFRT

Chids STAC ID J ‘Date of Birth as ksted on EFRT

[

Race Ethnicty as ksted on EFRT

] Change Child's First Name to:
] Change Child’s Middle Initial to:

[[] Change Child’s Last Name to:

]

(




STACUnit: STAC's

® SED’s STAC Unit reviews and approves children’s evaluations and
STAC-1's from counties.

® Approves evaluations (STAC-5).
® Approvesservices (STAC-1).

PRESCHOOL STAC-1 . J5ietalaiiy SEFARTME
(Updated July 2023)

® Reviews and approves special programs/services: | &= B
® RNsand LPNs (STAC-812).

Pursuant to Section 4410 of tha Education Law

® Assistive Tech Device.

® "“OTHER” type of evaluation components.




® Processes AVL return files.
® @Grants extensions to AVL due dates.

Returns AVLs if there are errors.

® Issues AVL adjustments based on STAC changes.

STAC Unit: AVL's

® SED's STAC Unit issues and processes Automated Voucher Listings (AVL).

® Issues AVLs for specific school years over three years.

THE STATE EDUCATION DEPARTMENT / THE UNIVERSITY OF THE STATE OF NEW YORK

System to Track and Account for Children (STAC) and Medicaid Unit
AVL Schedule — Section 4410 — Preschool

April 2024 — March 2025

Apr May Jun Jul Aug Sep Oct Nov Dee Jan Feb Mar
#12
2020-21 Final
202122 #09 #10 #11
2022-23 #05 #06 #07 #08
2023-24 #01 #02 #03 #04
Services
#12
2()- *
a2l Final
2021-22 #09 #10 #11
2022-23 #05 #06 #07 #08




® SED’s STAC Unit posts approved programs and rates.

(The STAC Unit does not set the rates.)

® Posts rates and rate changes to EFRT and Agency Files.
® The CPSE Portal uses Agency Files to collect program and rate changes daily.
® Preschool imports the latest program listing from the CPSE Portal.

® (When SED'’s Rate Setting Unit releases new rates, there may be a delay
between the release and the STAC Unit posting the new rates.)

STAC Unit: Programs & Rates

Download PROVIDER Information Files

File

Provider
Provider
Provider

Program (all years)
Program (all years)
Program {2010-11}
Program {2011-12)
Program {2012-13)
Program (2013-14)
Program {2014-15])
Program [2015-16)
Program (2016-17)
Program [2017-18]

Program {2018-19)
Program [2019-20)
Program (2020-21)
Program {2021-22}
Program [2022-23)
Program (2023-24)
Program {2024-25)

Program

File Type/Size
ASC

T

data dictionary

Download PROGRAM Information Files

ASC

data dictionary

List of Public School Districts




Rate Setting Unit

SED’s Rate Setting Unit approves and issues all rates for Preschool Services.

® Approves CB & SEIT providers’ new rates for their programs.
® Adjusts CB & SEIT providers’ existing rates for their programs.
® Approves Evaluation Rates for SED-approved evaluators.

® Approves Related Services (RS) rates for each county.

® Although each county sets its own RS rates, there is a maximum rate for different service types, and whenever that needs
to be changed, the Rate Setting Unit needs to approve them.

Board of Regents | University of the State of Mew York

A'NYSEDL}"J"J | ‘ | Search Rate Setting Unit ‘
NEW YORK STATE EDUCATION DEPARTMENT

About NYSED Program Offices News Room Business Portal Finance & Business Policy & Guidance

Rate Setting Unit

Announcements | Memos NYSED / Rate Setting Unit/

Rates & Methodology Rate Setting Unit

SEDFIN
I R The Rate Setting Unit establishes special education tuition rates signin
Grants for approved programs educating students with disabilities ages {Hours of operation
weekdays 7:00 AM to
= 3 to 21 years old who have been enrolled pursuant to articles 81 5:30 PM)
raining

and 89 of the Education Law. Approved program providers may be Register




Medicaid in Education

® SED’s Medicaid in Education handles all Medicaid Policies for Preschool.

® Provides training and guidance for Medicaid processes:

® Claiming and reimbursement for CPSE and CSE services.

® Creates and updates all Medicaid Policies for CSE and CPSE Services.

Board of Regents I University of the State of New York

AVNYSEDCIU’ | | | Search Medicaid |
NEW YORK STATE EDUCATION DEPARTMENT Index A-Z | Calendar

About NYSED Program Offices Mews Room Business Porial Finance & Business Policy & Guidance

Home MYSED / Medicaid in Education / Home Page

News/ANnouncements — .
NYS Medicaid in Education
Certified Public Expenditures
[CPEs) School Supportive Health Services Program

: Preschool Supportive Health Services Program
ICFSICRPS

Provider Policy and Billing

Handbook Click Announcements for recent updates




Interactions with SED

® The Preschool program interacts mainly with the STAC Unit:
® |STACID's|STAC-1's| STAC-5's | AVL's |
® Submitting files to and receiving files from the STAC Unit.

® Imports programs and rates from the STAC Unit for providers to bill under.

® The County Representatives interact with all three SED Units relating to
Preschool.

® Sending STACs with special programs to the STAC Unit on paper.

® Asking the STAC Unit on what and how to enter services into an STAC.

Submits new RS rates for the Rate Setting Unit to approve.

Asking Medicaid in Education for questions regarding Medicaid claiming and policies.




Getting Started with Preschool
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Getting Support

® If you need assistance with Preschool, you can always contact us for
Support.

® Our office is opened Monday-Friday from 8am to 5pm, we close for lunch
from 12pm to 1pm.

® You can reach us through email at preschoolsupport@cpseportal.com

® You can also email your Preschool CRM directly

® If you'd prefer to call our phone number is (518) 393-3635



Go To Meeting

® We use Go To Meeting for our support meetings.

® In order to best assist you, we ask you to share your screen and may
sometime ask for keyboard and mouse control.



Joining a Go To Meeting

shboard X ~ Golo el -

When you Join a go to Meeting you S Fpnignis
h ave tWO O pt i O n S : ) This site is trying to open GoTo Opener.

https://meet.goto.com wants to open this application.

[] Always allow meetgoto.com to apen links of this type in the associsted app

® Browser or Desktop o

-

® We recommend joining from the
desktop as the desktop app has much
more functionality.

How do you want to join oday?

Preschool Support

® Once you select the Join from desktop S, e

your browser Wi” display a pop Up Connects faster and has al the usual L.aun:hesthefuﬂappwihexkasllkep
window, select the "Open Go To e
pener” button.

Remember my choice



Choosing your audio settings in Go To Meeting

Next you will see the audio screen

N
|
[ @ Another app s using your camera.

There are two choices, computer audio il
or phone audio

Microphones

sssssss

® If you have a headset and microphone,
you can choose computer audio.

# ® A 0 Phone audio
® If you do not have a headset or |
microphone you can always call in using
e provided number. ) Preschoo) Support

B Ok, I'm ready
llllllllllllllllllllll



Select content you want to share

Screens

® To share your screen, click the Share button at
the bottom of the screen.

® Thenclick on the Screens tab, choose the
screen that you want to share and then click
the Share button.

Indude media sound @ Optimize for video @ Include GoTo interface (1




o EK

Remiote control requests

() William Bell

® If we need to take control of the screen, we will
send out a remote control request, which will
appear as a small pop-up window in the top- Allow all
left corner of your GoTo interface. Clicking
"Allow all” will grant us the permission to
remote control the screen that you’ BW

Yo

Benny Woolbert




Navigating Preschool
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Opening Preschool

® Your Preschool Icon should always point to c:\program
files(x86)\Preschool\Launcher.exe

® Theicon If your launcher is not pointed at the correct place, you may get an
error when attempting to open Preschool. If this happens, please contact us.



In Preschool, the Help Tab has the About
Preschool selection.

This will tell you what version of Preschool you
are running as well as the database version.

The executable version will always have
additional numbers ex (5.31.13) while the
database version will only have two sets of
numbers (5.31)

It will also display a link to the Network Path to
the Production folder on your County
Network.

The Master Folder link will open the
Production folder

Help
Contents

Search For Help On...

I L) =

Check For Mew Version

About Preschool..,
Suffie |

|
&7

.“E“E Copyright James McGuinness and Associates

$3373 JAMES McGUINNESS
mi & ASSOCIATES INC.
Consultants

Executable Version = 5.31.13

Database Wersion = 5.31

This software iz designed to assist NY'S counties
with the administration of the 4410 Preschool
Program for Children With Special Needs.

Master Folder

]b:\Dntario\.D ntano0ndMASEOL2013

System Info. .




® Look Up child, there are two ways to look up children.

® The first way is the child list, it will display a list of all children in your Preschool system for all school
years.

® You are able to filter the list based on the last name, DOB, or District.

® To open the child list click the Look Up Child button at the top left.

%2 Preschool (24-25 2 Maonth) & ChildNew
File Child / Services
urrent Child DOB Eligibility STACID  Cumrent S5e ~ Dop oo District Fi|tEriAIIDistricts _:]

Payments Claims Providers CPSEPortal Reports Medicaid Maintenance 5 Saareh Name |

Lookup Child | | | |24-25 2 Mo
= = Lasttame Firsth ame Ak DOB Y Sex | SSMNumber | District SED StacID | CIM =
| Child / Services j i | ]
| . Chil A

> - | 03/2415 | M CANANDAIGLA  |H77123
Child 110917 | M GEMEW CITY 50 | k02829
: mA812|F EAST FE4536
Last Name* | e T e

& Name (" AKA —



® If you press Ctrl+F on your keyboard you will
open the new child search function.

® This search has additional fields that you can
use including the STACID, ESID, eSTAC's
Student Number, and CIN.

® This search can be made the default search for
Preschool if you choose.

| Mame [Last First] I

| Childhew

| SED STACID i—“
D ate of Birth: WM /D DAY v:ﬂ = |
Electronic Service [D I

CIN

—

Buarm on or After

12/ A5

-

Search |
Clear

e5TACs Studert # 1




Last Name* ]JAEEIE\E Suffi ]

First Mame*  [JOHN K.l

wa _ Ahernae anes |
—_— [orzi2020 [Bw| £ oo aessrics

Sew M Race/Ethnic: [whie [

District* |aLBaNY CITY SD [
Foster County ] L.I

® Once you have looked up a child, the child e
. ol STAC ID Current Sess. :ﬂ 1
screen Wl” ShOW some baS|C InfO abOUt the ‘EldlMUEBEID |24-25'||:|M0nth “':]i | ‘ RS 5T.5T1
child.

" . . L Rl 1/21/2020 071401423 - 08/31/25 |M0OS690 24-25 10 Month > E ﬂ HEgEST LT
® You will see the name, eligibility, STACID, = s ]
Services in the current session as well as other == e T

e

STACID ;W“ :
. N N DOE l— Gender Fiace/Ethricit
demographic information e = :
Schodl Year
. [ ] ¢ ShawaiDelsls % Onl show delals for selected STAC
® If you click on the Blue STACID at the top of
t h e SC ree n, t h e S E D SU m m a ry | nfo rm atl O n Wi I | | Vear [Session| Rectt | Begin | End | Type |Amd] District ame. [ sEduc Piovider | Muli | ProvisEval | Issued | Summary| CPSE Code | Provider
display
EI| _ i
[ Service | Piogiam | Begin | EndDate [ His/Day | Days/week| dide ]mdeﬂaxf Ti‘v‘;/ﬁrui I0-min sess FTE Rate | Appoved | Piior Claimed | _Avaiable
K| i
Clase




Side Navigation Options
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® The Left hand side of Preschool has navigation
options.

® The Child/STAC Info button allows you to see
the child demographicinfo, STAC's, and Eval'’s
screens.

® The Center Based button takes you to the
Center Based Enrollment screen which will
display any CB or CBRS enrollments.

® The RS/SEIT button takes you to the RS/SEIT
Enrollment screen, which will display any SEIT
or RS enrollments.

Child / Services

Fr:.-l

Child } STALC Info

Transportation




Lhid # sevices

Child / Services

Child / S ervices '
Paymentz

Child / Services  Payments  Clai

Child / STAC Info Payments Claims Providers CP

Center Based . : Mew Enter Invoices
nter Invoices
RS / SEIT Enter Inveoices
i e i
Transportation ':"3‘\'13; Agency Rate Adj.
§
Summary ."I-".QEI'IE:_'.-' Bate .":".I:li. Check Log

AP Import / Export

Transportation

Create Elect Return

® There are additional Side Navigation options
should you choose to use them.

® These side navigation options generally display
the same options as the Tabs do once you
choose a category.

¢ If you “got lost” in the side menu, you can
always click the top “Child/Services” folder to
get back to the “Familiar Four”.



Navigation Tabs
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® Along the top of the screen are Tabs

® Each tab has options to select once you mouse over the tab

= Preschool (25-26 2 Month)

File Child / Services Payments Claims Providers CPSEPortal Reports  Medicaid  Maintenance  System View  Window  Help

. s | Current Child DOB Eligibility STACID  Curent Sess. | E
Lookup Child 4sad® || ! | [25.26 2Month | Q
l'. S ————S—S—S—S—S—S—S—~S—~—~—~<—~—~—~—~—~—~—~S—~S—~S—MPMMmm——,§

va Preschool (25-26 2 Month)

File Child/5ervices Payments Claims Providers CP3E Portal Reports Medicaid Maintenance Systern View  Window  Help

S Ty Eligibility 'STACID  Curent Sess. | =
Lookup chudg [ e | | |25-26 2 Month = | :

Child / Services A Agency Rate Adj.
Check Log

AP Import / Bxport
Last Mame™ |

Child 1




When you are working with multiple

. ] ) Maintenance Systemn
different windows in Preschool, and et

D  Cument Sess.

The “Window” menu.

Vies. Window Help

=
-~

you need to get to a previous screen

_ |24-25 2 Morth |
that you were working on.

Instead of closing all the other
screens. You can use the “Window”
menu to bring the screen you want
back to the top.

Cascade

Tile Harizontal

1 Child & STAC Maintenance
2 Center Based
3 Enrollment RS / SEIT

4 Transportation Enrcliment



Grids
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® Selecting items on grids can be done in three primary ways
® Single Select (Left Click)
® Multi-Select (Hold the Ctrl Key on the Keyboard and Left Click)

® Multi Select Range (Left click on one row, then Hold the Shift key and click on another row above or below to
select all rows)

® Thisis usually done on the Payment or Attendance screens.

Status PaymentBatch | BatchDate | Check# CheckDate | ClaimBatch ClaimD ate | RecHt | ClaimServiceType
09/2023 $4. 207 88 PaID 24-2059 05/23}2%

$4. 207 88 24-2059 05/23/25

$4.207.88 24-2059 05/23/25

12/2023 $4 207 88 40 24-2059 05/23/25 EDUC

-“ || $4.207.88 ____

A 0272024 $4.207.88 4 24-2059 05723425 EDUC
A 0372024 $4.207.88 24-2059 05723425 X1 EDUC
A D472024 $4.207.88 24-2059 05723425 X1 EDUC
A 0572024 $4.207.88 24-2059 05723425 X1 EDUC
A 0672024 $3.156.08 D0 24-2059 05723425 =1 EDUC




Once you have something selected in a Grid, you may be able to right click it depending on what it is.

® Attendance and Payments can be moved
Right clicking on enrollments can display attendance

Right clicking on a STAC can display the Transmission History.

[¥  TEST Move To Different STAC > MinutezPerSeszsior | B= Start Date | RsExp D
TEST Move To Different Enrollment > Ao I..—_ll—l.—lllq- E I..—_l.l 1N
p e B nFir i P
Move Payments To Different STAC » i D | 5.F|-| a}r .IﬁlnttEﬂ d ance
Move Payments To Different Enrollment > ;
Spht Payment Show Payment History
Reclaim Selected Payments Sh':l'w ESTA':E‘ DEtEH|5

Mark Payments as Claimed Manually

Clear Manual Claim Status

bl 229 L ¢ ighb ELELIHUMIL

Show STAC-1 Transactions

Resync Match and Summary Infoermation



Core Screens
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Child Screen, Child Tab

® The Child Screen has three tabs
® Child, STAC, and Eval

® The child tab displays demographic info as well as the STACID, Medicaid info, and Claiming info

=7 Child & STAC Maintenance

Child 1

Last Name*  [JACOEIE

Suffie |

First Name* jJ OHN

ML [

AEA |

Alternate Names

pop: [vzivanzn (o] S anmns- aoian s

e [ RacesEthrict [white &
District |ALBANY CITY 5D =
Foster County ! _:J

Address |

Stacs

Child &ctivity Log

Wiew Full Log

Ewals

stacio  [Wosewn | . | Mew
s5H = Appl

Apply
eSTACs Student # Lookup Child
CIN # Delete

Add Child to CIM Lookup ‘ Summary

|

Medicaid Consent and Eligibility | [~ Has Assistive Tech Device

Upload ta CPSE Portal [~ HasABA

Add

‘ I Categom

| addedBy | Added | |




Child Screen STAC'sTab

® The STAC's tab will display all of the STAC's (both STAC-1's and STAC-5's) that have been entered
into Preschool

® From here you can make changes to your STAC-1 and see transmission history for them

=7 Child & STAC Maintenance

Child ‘; Stacs Ewals
Tupe | Session District Rejected Last Sent Last bpprd | Rec# | Year SEDStacH | X-Mit DualSTAC | Force | OKTaSend | Status Wew
[ 3] 2026 2 Month | ALBANY CITY 50 MOBES0 | ELECTRONIC |l I L —
SEIT | 242570 Month | ALBANY CITY 5D MOBESD | ELECTROMIC C Id Apply
23-24 10 Month | ALBANY CITY 5D MO05630  |ELECTRONIC r [ 1 &

Delete

Details




Child Screen Eval’s Tab

The Evals Tab will display all of the Evals that have been entered for the child.

From here you can make changes to the Evals

\| ; Evals

ACHIEVEMENTS

North Colonie 0809

Physical Therapy

Occupational Therapy

Education

Audiological

Dther (Physician]

Other (Non-Physician)

e o —
S R

Pauchiatric

Music

Teacher of the

Morth Colonie 0909

Disabled | Camments §TA‘EIU! Evaltt | TranslationCost
k50210 0 $0.00




SED Summary
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® Clicking on the Blue STACID will display the SED Summary info.

® You will be able to see any STAC-1 that are approved by SED as well as any STAC-5's for a given
School year

® The SED summary info must be manually imported to be kept up to date. (We recommend
importing once per week)

gibility STACID  Curent Sess. | ] cB
ey 5 !
/23 - 0B/31/25 |MO56I0 o

SED Child Summary

Last Hame | Fitst Name [ MI'ZI_" STACID [Mos6a0
DOB ._':fiéndefl . ﬁac.eé-’EMéiﬂ:] | |
| i vals. ]
School Year
| *| " ShowAllDetak (% Ol show detals for selected STAC
STACs
i ‘ear 1Session! Rectt ] Beain End Type IAmd] DistrictM ame Educ Provider I Multi Frovy iz Eval Issued Summaryl CPSE Code Pravider
L] i1
D etails
] Service] Programl Eegin ]EndDate Hrs/Dray _]DaysMeek Aide’ Ajde Rate ]Ind.-’ﬁrpi 30-min sess FTE Fiate Approved | Prior Claimed | Available
L _| i
Cloze




Importing Summary Files

Maintenance  System View Window Help
Medicaid s

SED Data > Download Summary
Contract Numbers By Year SED Summary
P . Claiming Notes Reasons EVAL Summary
To Import Summary Files go to the S —
ICD Codes

Program Provider Comparision

Maintenance tab > SED Data and click on =

Transporters
Misc Codes Electronic STAC-5

‘Import Summary Data from CPSE Portal’

Import Eval Summary Duplicate STAC IDs

SED Eval Summary Evaluation Number Conflicts

Duplicate Eval Components

® You can use this whether you use CPSE Portal e

et N e i Frag 0 Children Without 2 STAC ID

O r n Ot . Programs/Providers Impert Summary Data from CPSE Portal
Program / Provider Comparison SED FTE / Tuition Caleulator

Recalculate Programs

® This process should be completed on a weekly i
baSiS. Requirements

CPSEeXchange >

Download Billing Files
Service Types

SED Growth Factor
Aide Per Diem

Preschoolsupport@CPSEPortal.com



This is the Import Summary from CPSE Portal
screen.

Start by selecting the school year you want to
import data for

Then click Import Summary

Finally click the Update/Auto Match button

Preschoolsupport@CPSEPortal.com

2 Import SED Summary from CPSE Portal

School Year: | EiEEs

Evaluations

Import Ewaluation Surnmary

Services

J Import Service Surmary ]

Update Evalustions From SED
Summary

] Auta Match Services [STAC-1) ]




Closing

Support@CPSEPortal.com




Preschool Training —
Knowledge Base

Knowledge Base provides numerous articles,
nings, webinars, and other pertinent information
t will help answer your questions before having
contact Preschool support.

u can simply click the Knowledge Base tab in the
ortal or you can go to:

“EPORTAL
ttp://support.cpseportal.com/kb a

Community

Knowledge Base

;

Support@CPSEPortal.com




Handy Links

STAC Unit Website https://www.oms.nysed.gov/stac/

D Rate Setting Unit Website https://www.oms.nysed.gov/rsu/

D Medicaid in Education Website https://www.oms.nysed.gov/medicaid/

ED STAC Forms https://www.oms.nysed.gov/stac/contact us/form requests/

ED Medicaid Q&As https://www.oms.nysed.gov/medicaid/q and a/

SED Medicaid Training Materials https://www.oms.nysed.gov/medicaid/training materials/

SED Medicaid Alerts https://www.oms.nysed.gov/medicaid/medicaid alerts/

Support@CPSEPortal.com



Knowledge Base Articles

Send STACID Batch to SED http://support.cpseportal.com/kb/a168/stac-id-process.aspx

® Send STAC-1 Batch to SED http://support.cpseportal.com/kb/ai13/submitting-stac-1s-to-nysed.aspx

® Send STAC-5 Bathc to SED http://support.cpseportal.com/kb/a61g/submitting-stac-5s-to-nysed.aspx

® Import Summary Data http://support.cpseportal.com/kb/aii5/download-sed-summary-file-stac-
eval.aspx

Support@CPSEPortal.com



Closing remarks

ition to the Knowledge base, our Helpdesk is available through email at
choolSupport@CPSEPortal.com

hen sending an email:

® Do not use child’s name
® UseSTACID #orESID #

® Include your county, and info needed

Or you can reach out to your designated Preschool CRM directly via email or phone

Support@CPSEPortal.com



